
To connect to another computer on your network

You can easily connect to other computers on your network. Just double-click the Network Neighborhood icon on your desktop, 

and then double-click the computer you want. If you don't see the computer you want, double-click Entire Network.

If you don't have networking available (the Network Neighborhood window is empty or the icon is missing), you need to set up 

networking.
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To assign (map) a drive letter to a shared network resource from the desktop or the Explorer

1 In the Explorer or on the desktop, right-click My Computer or Network Neighborhood, and then click Map Network Drive.

Or, click     on the toolbar.
2 Click the Path box, and then type the path to the resource you want. For example:

\\computername\foldername (shared directory)

Or, in Shared Directories double-click to expand a network, domain or workgroup, or computer, and then select a shared 

directory.

3 To connect under a different user name, type the name in Connect As. If the user account is in a different domain, use the 

format domain\username.

4 If you do not want to connect to the shared directory each time you log on, clear Reconnect at Logon.

Notes and Tips
If the toolbar is not visible, click the View menu, and then click Toolbar.
To map to a resource you have used recently, click the arrow to the right of Path, and then click the resource you want. 

The previous ten paths are displayed.
In the Explorer, you can also click Map Network Drive on the Tools menu.
If you know the name of a computer but want to view its shared directories, type the computer name preceded by two 

backslashes (\\) in Path and then click OK. The name of the computer's first shared directory is added to Path and the computer's 
shared directories are displayed in Shared Directories. To connect to a different directory, select it in Shared Directories. 
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To assign (map) a drive letter to a shared network resource in Network Neighborhood

1 In Network Neighborhood, double-click the computer that has the shared resource.

2 Right-click the shared folder and then click Map Network Drive.

3 To connect under a different user name, type the name in Connect As.

4 If you do not want to connect to the shared directory each time you log on, clear Reconnect at Logon.
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To remove a drive-letter assignment

1 In the Explorer or on the desktop, right-click My Computer or Network Neighborhood, and then click Disconnect Network 

Drive.

Or, click  on the toolbar.
2 In Network Drive, click the resource whose drive-letter assignment you want to remove.

Notes and Tips
If the toolbar is not visible, click the View menu, and then click Toolbar.
In the Explorer, you can also click Disconnect Network Drive on the Tools menu.



A collection of computers that share a common directory database and security policy. Each domain has a unique name.



The group of computers that your computer is in if the computer does not participate in a domain. A workgroup is generally 

composed of the computers you are most likely to communicate with, containing most of the network resources (such as files 

and printers) you will want to use.



To see shared network printers and folders

1 Double-click Network Neighborhood on your desktop.

2 Double-click the computer whose shared resources you want to view.

Note
To see additional printers and folders that are available, click Entire Network.



An item such as a folder, file, or printer that is available for you to use on the network.



To find a computer on your network

1 Click Start, point to Find, and then click Computer.

2 If you know only the name of the computer you are searching for, type it in Named—for example, AIREDALE.

3 Click Find Now.

Tip
You can also find a computer by double-clicking Network Neighborhood on the desktop.
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To use a shared network printer

1 In the Network Neighborhood window, locate and double-click the computer on which the printer you want to use is located.

2 Double-click the printer icon.

3 On the File menu, click Install.

The printer is added to your Printers folder.

Note and Tip
To see which computers have shared printers attached, click Details on the View menu, and look for printer names or 

descriptions in the Comment column of the Network Neighborhood window.
After you have installed a network printer, you can use it as if it were attached to your computer. For related topics, look 

up "printing" in the Help Index.



A printer attached to another computer that has been made available for you to use on the network; also called a "network 

printer."



To open a shared folder on another computer

1 Double-click Network Neighborhood, and then double-click the computer in which the shared folder is located.

2 Double-click the folder you want to open.

Tip
You can assign a drive letter for shared folders that you connect to often.
To see more computers in the Network Neighborhood window, double-click Entire Network.
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A folder on another computer that has been made available for you to use on the network.



Click Help Topics for a list of Help topics. 



 Network Troubleshooter

This troubleshooter will help you identify and solve problems with your computer's network. Just click to answer the questions, 

and then try the suggested steps to fix the problem.

What's wrong?

              I can't see other computers in Network Neighborhood.  
              I can't connect to a specific computer.   
              I can't share a folder or printer on my computer.   
              People on my network can't connect to my shared resources.  
              I can't set up a network adapter.  



Can people on the network see your computer in Network Neighborhood?

              Yes.   
              No.   



When people view your computer, do they see the correct shares?

              Yes, but they can't connect to them.  
              No, they see incorrect shares.  
              No, there are no shares available.   



Be sure the Server service has been started

1 Click here        to display the service status.

2 In the Service column, find Server and look at the Status column.

Has the Server service been started?

              Yes.   
              No.  



Next steps

In the Service column, click Server, and then click Start.

Note
You must be logged on as a member of Administrators to start the Server service.

Did this fix the problem?

              Yes. I can share my files now. Close the troubleshooter.   
              No. I was unable to start the Server service.  
              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Have you installed new hardware on your computer recently?

              Yes.  
              No.  



Does the Event Viewer’s System Log report any errors ?

1 Click Start, point to Programs, point to Administrative Tools, and then click Event Viewer.

2 Click Log, and then click System.

3 When viewing the event log, look for the latest event labeled "EventLog" and review entries as time becomes more current.

Are there events recorded that describe protocols or network adapter card failures?

              Yes.  
              No.  



Configure your new network adapter card

1 Click here        to display the Adapters tab in Network Control Panel.

2 Click Add, and then select the correct network adapter that is installed.

3 If necessary, enter the path to the installation files.

4 Make appropriate modifications to the configuration (if presented).

Note
You must be logged on as a member of Administrators to make the changes above.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Is the network adapter card already installed in your computer?

              Yes.  
              No.  
              I don't know.  



Install your network adapter card

1 Turn off and unplug your computer, and install the network adapter card, following the manufacturer’s instructions.

2 After the network adapter card is installed, click here        to configure the new hardware.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Check to see which network adapter card is installed in your computer

1 Click here        to display the Adapters tab in Network Control Panel.

2 Look at the list to see whether a network adapter card is installed.

A network adapter card has the  icon beside it.

Did you find a network adapter card?

              Yes.  
              No.  



Check the network adapter card and slot

1 For reference, print this procedure by clicking Options and then clicking Print Topic.

2 Shutdown Windows NT.

3 Turn off your computer and unplug it.

4 Following the instructions in your computer manual, remove the cover of your computer.

5 Locate your network adapter card, and be sure it is properly seated in the slot.

Notes and Tips

If the network adapter card is properly seated, the slot could be faulty. Try moving the network adapter card to another slot 
in your computer. For instructions, see the documentation for your network adapter card.

If moving the network adapter card to another slot does not solve the problem, it probably needs to be replaced.

Are you able to set up the network adapter card now?

              Yes. Close the troubleshooter.  
              No.   
              Return to the beginning of the troubleshooter.  



Can you see any computers in Network Neighborhood?

              I can see some but not all of them.  
              I see only my computer.  
              I can't see any computers on the network.  
              I receive an error that the network is not present or not started.  



Do you see the Entire Network icon in Network Neighborhood?

              Yes.  
              No.  



View the Entire Network

Double-click Entire Network.

Can you view other computers on the network?

              Yes.  
              No.  



Not all the computers are seen

When you open Network Neighborhood, it displays computers in the workgroup or domain that contains your computer.

              The computer I  ’  m trying to locate is in another domain or workgroup.  
              The computer I  ’  m trying to locate is in my workgroup or domain.  



Contact the administrator of the computer you want to connect to.

The computer you want to connect to may have a problem, or it may be disconnected from the network. Contact the computer’s 

administrator for more information.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



What problem occurred?

              I can't find the computer on the network.  
              I received an error "Incorrect password or unknown username."  
              I received an error "The network path was not found."  
              I can find the computer on the network, but I can't view the shared resources.  
              I can view the shared resources, but I can't connect to them.  
              A different problem occurred.  



Is the computer on the network?

1 Click Start, point to Find, and click Computer.

2 In Named, type the name of the computer you're looking for, and then click Find Now.

Did you find the computer?

              Yes.   
              No.   



Try to view the shares on the computer

Double-click the computer name in the list of found computers.

Can you view the shares on the computer?

              Yes. Close the troubleshooter.  
              No.   



Contact your administrator

Your computer may have a problem or you may have insufficient rights to start the service. Contact your administrator.

              Close the troubleshooter.  



Contact your administrator

Your computer may have a problem. Contact your administrator.

              Close the troubleshooter.  



Contact the computer's administrator

The computer you are trying to connect to may not currently have any shared resources available. Contact the computer's 

administrator for more information.

              Close the troubleshooter.  



Contact the computer's administrator

You may not have permission to use the resources on that computer. Contact the computer's administrator for access 

permissions.

              Close the troubleshooter.  



Be sure the network cable is connected properly

Be sure the cable is securely connected to the network adapter card.

Tip

If your network adapter card is a PC card (PCMCIA), be sure it is fully inserted in your computer. Then try to view the 
computers again.

Did this fix the problem?

              Yes. The computers are available now. Close the troubleshooter.  
              No, I'm still having trouble. What else could be wrong?  



Be sure the network cable is connected properly

Check that the cable is connected securely to the network adapter card.

Note

If your network adapter card is a PC card (PCMCIA), be sure it is fully inserted in your computer. Then try to set it up 
again.

Did this fix the problem?

              Yes. Close the troubleshooter.  
              No, I'm still having trouble. What else could be wrong?  



Check the network adapter card settings

1 Click here        to display the Adapters tab in Network Control Panel.

2 Click your network adapter, and then click Properties.

3 Check that the value for Transceiver Type (if it is available) is set to match the type of network cable you are using.

4 Be sure the other adapter settings match the settings used by your network adapter card.

Notes

The appearance and configuration of the adapter Properties dialog box depends on the type of adapter installed in your 
computer. Click Help for help provided by the manufacturer.

If you don't know what type of cable your network uses or what network adapter card's settings should be, contact your 
network administrator.

For reference, you can print this procedure by clicking Options and then clicking Print Topic.
You must be logged on as a member of Administrators to change adapter settings.

Did this fix the problem?

              Yes. Close the troubleshooter.  
              No, I'm still having trouble. What else could be wrong?  



Check the network protocol settings

1 Click here        to display the Adapters tab in Network Control Panel.

2 Be sure the name of your network adapter card appears in the list.

3 Click the Protocols tab, and check that at least one network protocol appears on the list.

4 Click the Bindings tab.

5 If the binding path to your network protocol is disabled (a  symbol shows to the left of the binding), click Enable.
6 Be sure all services appears in Show Bindings for, and that the hierarchy of bindings is displayed.

Tip

Be sure your protocol is the same one that other computers on your network are using. If it is not, you will be unable to 
see other computers on your network. If you don't know what protocol you should be using, contact your network administrator.

Did this fix the problem?

              Yes. Close the troubleshooter.  
              No, I'm still having trouble. What else could be wrong?  



Check the network protocol you are using

1 Click here        to display the Protocols tab in Network Control Panel.

2 Be sure that you are using the correct protocols.

Notes

If you don't know what protocol you should be using, contact your network administrator.
Be sure your protocol is the same one that other computers on your network are using. If it is not, you will be unable to 

see other computers on your network. If you don't know what protocol you should be using, contact your network administrator.

Is the correct protocol listed?

              No. How do I install another protocol?  
              Yes, but I'm still having trouble. What else could be wrong?  
              I don't want to do this now. Close the troubleshooter.  



Browsing is unavailable

The problems you have mentioned indicate that browsing is unavailable on your computer. Contact your network administrator 

for assistance.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Next steps

You've encountered a networking problem that the Network Troubleshooter can't help you solve.

Here are some more steps you can try:

Be sure that the network cable is connected to your network adapter card and to the network.
Be sure the network adapter card is installed and set up correctly. For more information, see the documentation for your 

network adapter card.
Find out whether the network is working correctly.

For more information to help you solve the problem, contact your network administrator, or try looking in the documentation for 

your network adapter card or software.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



I receive a dialog box that states my username or password is incorrect.

              I used the wrong case when entering the password.  
              The resource I am trying to use is in another domain.  
              I need to use a different username for this share than the one I am currently logged on with.  
              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Re-entering your password

At the prompt "Incorrect password or unknown username," type your password in Password using the correct case, and then 

click OK.

              I still receive this dialog box, and cannot connect to the share.  
              I was able to connect to the share. Close the troubleshooter.  



Using Connect As to use a different username and password

Use Connect As to use a different account to connect to the computer. For example, if you logged on using your domain user 

account and you want to connect to a computer in a domain that does not trust your domain, you can enter a user name and 

password from the domain on which you are trying to connect to that does have appropriate rights and permissions to use the 

resource.

In Connect As, type the domain name followed by a backslash character (\), and then your user name on that domain (for 
example, MyDomain\SallyA), and then type the appropriate password.

              I still receive this dialog box, and cannot connect to the share.  
              I was able to connect to the share. Close the troubleshooter.  



I receive the message Network Path Not Found

The computer may not be available or connectivity between this computer and yours is not available, possibly because 

incompatible protocols are installed.

Check with the administrator of the computer you are attempting to use resources on, and verify that the computer is running and 

the correct protocols are installed. If the remote computer is running Windows NT Workstation or Windows NT Server, be sure 

that the Server service is started on the remote computer.

              How do I check which protocols are installed?  
              Return to the beginning of the troubleshooter.  



Checking permissions for shares and NTFS partitions

If users are unable to connect to your shared resources and you have determined that connectivity between computers is not a 

problem, it is possible that the users have been denied access because of the permissions set for the shared resource, or for the 

files themselves if located on an NTFS partition.

To check the permissions for files and folders on NTFS partitions

1 In Windows NT Explorer, right-click the folder that is shared.

2 Click Properties, click the Security tab, and then click Permissions.

Does the user account or group you want to give access to appear in the list?

If no, click Add to add the user or group to the permissions list.

To check the permissions for shares

1 In Windows NT Explorer, right-click the folder that is shared.

2 Click Sharing, and then click Permissions.

Does the user account or group you want to give access to appear in the list?

If no, click Add to add the user or group to the share permissions list.

Note

You must have sufficient permissions to make the changes above.
              Yes, users can connect to the shares now. Close the troubleshooter.  
              No, I  ’  m still having trouble. What else could be wrong?  



I’ve forgotten my password.

Contact the domain administrator. You must have a valid password to use resources on the domain.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Contact your network administrator

Ask your network administrator to review the Event Log errors.

              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Installing another protocol

1 Click here        to display the Protocols tab in Network Control Panel.
2 Click Add, and then select the protocol to install.
This step may require the installation media to be available.

Notes and Tips

After successfully adding the protocol, you must restart the computer before the changes will take effect.
You must be an administrator of the workstation to add protocols.

              Close the troubleshooter.  
              Return to the beginning of the troubleshooter.  



Verify your computer name

Click here 
    to display the Identification tab in Network Control Panel.

Does Computer Name match what other users are attempting to connect to?

              Yes.  
              No. Give the correct computer name to the remote user. Close the troubleshooter.  



Verify that the share has been created.

1 Open Windows NT Explorer to the subdirectory that is shared.

2 Verify that the share icon (an outstretched hand) is visible beneath the folder.

Note

You must have sufficient rights to make the changes above.
              I verified this, but users still cannot see the share.  
              No. It was not shared correctly, but this has been corrected. Close the troubleshooter.  



Be sure the Workstation service has been started.

1 Click here        to display the service status.

2 In the Service column, find Workstation and look at the Status column.

Has the Workstation service been started?

              Yes.  
              No.  



Next steps

In the Service column, click Workstation, and then click Start.

Did this fix the problem?

              Yes. I can browse the network now. Close the troubleshooter.   
              No. I was unable to start the Workstation service.  

Note

You must be logged on as a member of Administrators to start the Workstation service.
              Return to the beginning of the troubleshooter.  



Browsing other domains or workgroups

An icon of three network computers indicates a workgroup or domain.

Double-click a domain or workgroup icon to see a list of computers.

Tip

Individual computers are represented by an icon of a single computer.
              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



If you are using the TCP/IP protocol, can you ping the computer you are attempting to connect to?

1 Click Start, point to Programs, and then click Command Prompt.

2 Type PING following by a space and the computer name.

              I receive the error message "Bad IP address <computername>."  
              I receive replies from the remote computer.  
              I receive an error "The name specified is not recognized as an internal or external command, operable program or batch   

file."



Bad IP address

In a TCP/IP environment, when you use the name of the computer, or "friendly name," this name must be resolved to an IP 

address so that communications can be established between your computer and the remote computer. This error indicates that 

the name you entered could not be resolved to an IP address.

Verify the name of the computer, and then contact your administrator.
              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



I receive replies from the computer.

When you use the name of the computer (or "friendly name") in a TCP/IP environment, this name must be resolved to an IP 

address. so that communications can be established between your computer and the remote computer.

If you are receiving replies but are unable to connect to shared resources, the remote computer may not have the resource 

shared, or the Server service may not be started on the remote computer.

Contact the remote computer’s administrator.
              Return to the beginning of the troubleshooter.  
              Close the troubleshooter.  



The name is not recognized when I run the PING command.

If you receive this error, TCP/IP might not be installed, which means that the PING command is unavailable.

              How do I check which protocols are installed?  
              Return to the beginning of the troubleshooter.  



Specifies the name of the computer for which properties are listed.



Specifies a description or other comment about the computer.



Specifies the name of the selected domain or workgroup of computers.



Specifies the name of the shared resource for which properties are shown.



Specifies the name of the network for which properties are listed.



Specifies the type of network or operating system.



Provides a space for you to type the name of the shared computer you want to find (such as marketing). The name, location, 

and comment (if any) for that computer are listed.



Disconnect Network Drive

Disconnects your computer from a network drive.

 Select the drive or drives you want to disconnect, and then click OK.



Map Network Drive

Connects to shared directories on the network.

Click the following for information about the dialog box:

 Drive
 Path
 Connect As
 Reconnect at Logon

{button ,AL("a_net_connect;a_net_map")} Related Topics



Drive

Displays the first available drive letter for the connection. You can type or select another drive letter.



Path

Specifies the network path for the connection. A network path consists of a computer name followed by the name of a shared 

directory in the form \\computername\foldername, such as:

\\AIREDALE\PUBLIC



Connect As

 To connect using a different user account, type the account name in Connect As.

Notes

To connect using an account in a different domain, type the domain name followed by a backslash (\) and the user name 
for the account (for example, Sales\cristalw).

By default, you are connected as the user name you used to log on.



Reconnect at Logon

 Click to clear this check box if you do not want to connect to the shared directory each time you log on.



Map Network Drive

Connects to shared directories on the network. 

Click one of the following buttons for information about the dialog box: 

 Drive
 Path
 Connect As
 Reconnect at Logon
 Expand by Default
 Shared Directories
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Path

Specifies the network path for the connection. A network path consists of a computer name followed by the name of a shared 

directory in the form \\computername\foldername, such as:

\\AIREDALE\PUBLIC

You can:

Select a previous network path from Path.
Type the name of a computer and shared directory in Path.

Notes

In addition to uniform naming convention (UNC) names, such as the names of network servers, domain name system 
(DNS) names can be used in Path. DNS names use periods to separate each part of the name; such as:

\\accounting.jones.com.\public

For more information about DNS names, see TCP/IP online Help.



Expand by Default

By default, the list in Shared Directories expands to display the computers in your computer's domain or workgroup. 

To stop automatic expansion of the Shared Directories list, clear Expand By Default. 

Tip

Clear Expand by Default if you are connecting over a slow network (for example, through Remote Access Service). 



Shared Directories

Shows networks, domains and workgroups, computers, and shared directories. 

Double-click an item to expand the list. Selecting a shared directory places it in Path.



Enter Network Password

The user account you used to log on does not allow access to this shared resource. You must provide a user name and 

password for an account that has permission to access this resource.

 To connect using a different user account, type the account user name in Connect As, and then type the account 
password in Password.

Note

To connect using an account in a different domain, in the Connect As box, type the domain name followed by a backslash 
(\) and the user name for the account, such as: Sales\cristalw



Enter Network Password

The user account you are using to connect has a different password than the user account you used to log on.

 In Password, type the password for the account you are using to connect to this resource.




